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VUE D’ENSEMBLE DU PRODUIT

Merci d’avoir acheté le poste téléphonique à haut-parleur ClearOne Chat 50. Le Chat 50 est
un périphérique audio portable compatible avec une large gamme d’appareils pour une
communication mains libres et une lecture audio. 

Vous pouvez utiliser le Chat 50 avec un grand nombre d’appareils, notamment :

• Téléphonie par Internet (Skype et Vonage) 

• Téléphones d’entreprise (Avaya, Cisco et autres)

• Voix sur IP (Avaya, Cisco et autres)

• Téléphones mobiles (Motorola, Nokia et autres)

• Lecteurs MP3 (iPod et autres)

• Conférence sur Internet (IBM/Lotus Sametime, Microsoft NetMeeting et autres)

• Messagerie instantanée (AIM, MSN et autres)

• Visioconférence (Polycom, Sony et autres)

• Lecture de fichiers audio (iTunes, Quicktime, RealPlayer et autres)

• Jeux PC (TeamSpeak, Ventrilo, Roger Wilco et autres

ENTRETIEN ET ASSISTANCE

Si vous avez besoin d’informations supplémentaires quant à l’installation de votre poste téléphonique à haut-
parleur Chat 50, veuillez nous contacter. Nous serons ravis de recevoir vos commentaires afin de pouvoir
poursuivre l’amélioration de nos produits et ainsi mieux répondre à vos besoins.

SUPPORT TECHNIQUE

Téléphone : +1.800.283.5936 (États-Unis) ou +1.801.974.3760

Fax : +1.801.977.0087

Courriel : tech.support@clearone.com

Site Internet : www.clearone.com

VENTES ET SERVICE À LA CLIENTÈLE

Téléphone : +1.800.945.7730 (États-Unis) ou +1.801.975.7200

Fax : +1.800.933.5107 (États-Unis) ou +1.801.977.0087

Courriel : sales@clearone.com

RETOURS DE PRODUITS

Tout retour de produit requiert un numéro d’autorisation de retour (AR). Veuillez contacter le support technique
ClearOne avant de tenter de retourner votre produit. Assurez-vous de retourner tous les items expédiés avec
votre produit.

CHAPITRE 1 : INTRODUCTION
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INFORMATION DE SÉCURITÉ IMPORTANTE
Lisez les instructions de sécurité avant d’utiliser ce produit pour la première fois. Ce téléphone de conférence
n’est pas conçu pour effectuer des appels téléphoniques d’urgence en cas de panne de courant. Prévoir
d’autres arrangements pour un accès téléphonique d’urgence.

• Lire et bien comprendre toutes les instructions et suivre toutes les mises en garde indiquées sur le
produit.

• Débrancher cet appareil de la prise murale avant de le nettoyer. Ne pas utiliser de nettoyants liquides ou
en aérosol. Utiliser un linge humide pour le nettoyage.

• Ne pas utiliser ce produit près de l’eau, par exemple près d’une baignoire, d’un lavabo, d’un évier de
cuisine ou d’un bac à laver, dans un sous-sol humide ou près d’une piscine.

• Ne pas placer ce produit sur un chariot, une table ou un support instable. L’appareil pourrait tomber,
provoquant de graves dégâts au produit.

• Ce produit ne devrait jamais être placé au dessus d’un radiateur ou d’un contrôle de chaleur. Ce produit
ne devrait pas être encastré dans un meuble à moins qu’une ventilation adéquate soit assurée.

• Ce produit ne doit être alimenté que par le type de source d’alimentation électrique indiqué sur l’étiquette
de marquage. Si vous n’êtes pas certain du type d’alimentation dans votre emplacement, consulter votre
vendeur local ou la compagnie d’électricité.

• Ne pas surcharger les prises murales ou les rallonges électriques car cela peut entraîner un risque
d’incendie ou de choc électrique.

• Ne jamais répandre de liquide sur le produit.

• Pour réduire les risques de choc électrique, ne pas désassembler ce produit. Ouvrir ou Enlever les
couvercles peut vous exposer à des voltages dangereux ou à d’autres risques. Un réassemblage incorrect
peut provoquer un choc électrique lors d’une utilisation ultérieure.

• Débrancher ce produit de la prise murale et consulter le personnel de service qualifié pour l’entretien dans
les conditions suivantes :

a.  Lorsque le cordon d’alimentation ou la fiche est endommagé(e) ou effiloché(e).

b.  Si un liquide a été renversé dans le produit.

c.  Si le produit ne fonctionne pas normalement en suivant les instructions d’opération.

d.  Si le produit est tombé ou est endommagé.

e.  Si la performance du produit a manifestement changé.

• Éviter d’utiliser un téléphone pendant un orage électrique. Il peut y avoir un risque de choc électrique à
distance provenant de la foudre.

• Ne pas utiliser ce produit pour communiquer une fuite de gaz à proximité de cette fuite.

• Ne pas permettre l’utilisation de ce produit près d’un appareil médical de réanimation ou près de
personnes portant un pacemaker.

• Ce produit peut interférer avec du matériel électrique comme des répondeurs, télévisions, radios,
ordinateurs et fours à micro-ondes s’ils sont placés trop près.

Conservez soigneusement ces instructions
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DÉBALLAGE DU PRODUIT

Placez soigneusement le Chat 50 sur une surface plane. Assurez-vous d’avoir reçu tous les éléments
présentés à la Figure 1.1.

> Remarque :

    

ClearOne n’est pas responsable des dommages causés aux produits pendant le transport.
Adressez vos réclamations au transporteur. Inspectez soigneusement votre colis à la recherche de signes
évidents de dommage. Si le colis semble endommagé, conservez les boîtes d’origine et le matériel
d’emballage pour qu’il puisse être examiné par le transporteur. Contactez immédiatement le transporteur.

FIGURE 1.1 Composants du Chat 50
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INSTALLATION DU LOGICIEL CHAT 50

1. Insérez le CD Chat 50 dans votre lecteur CD-ROM/DVD. La fenêtre d’accueil de l’Assistant d’installation
(voir Figure 2.1) s’affiche.

2. Cliquez sur Next >. La fenêtre « License Agreement » (Contrat de licence) s’affiche (voir Figure 2.2).

CHAPITRE 2 : POUR COMMENCER

FIGURE 2.1 Écran d’accueil de l’Assistant d’installation de Chat 50

FIGURE 2.2 Contrat de licence pour Chat  50



6 Services techniques : 800.283.5936

3. Parcourez le contrat de licence et cliquez sur le bouton « I Agree » (J’accepte). Cliquez ensuite sur 
Next >. La fenêtre « Select Installation Folder » (Sélection du dossier de destination) s’affiche 
(voir Figure 2.3) s’affiche.

4. Cliquez sur le bouton afin de préciser si vous serez le seul à utiliser l’appareil (Just me) ou si toutes 
les personnes se connectant à l’ordinateur y auront accès (Everyone). Dans ce deuxième cas, cochez 
« Everyone ». Si vous êtes le seul à utiliser Chat 50, cliquez sur « Just me ». Cliquez ensuite sur Next >.
La fenêtre « Confirm installation » (Confirmation) s’affiche (voir Figure 2.4).

FIGURE 2.4 Fenêtre de confirmation de l’installation de Chat 50

FIGURE 2.3 Fenêtre de sélection du dossier de destination pour Chat 50
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5. Cliquez sur Next > pour lancer l’installation. La fenêtre « Installing ClearOne Chat » (Installation 
de ClearOne Chat) s’affiche (voir Figure 2.5). Une fois l’installation terminée, la fenêtre « Device 
Driver Installation » (Installation du pilote) s’affiche (voir Figure 2.6).

FIGURE 2.5 Fenêtre de l’installation du logiciel de configuration ClearOne Chat

FIGURE 2.6 Fenêtre d’installation du pilote pour Chat 50
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6. Cliquez sur Next >. Les pilotes pour Chat 50 ont été installés. Une fois l’installation terminée, la fenêtre 
« Completing the Device Driver Installation Wizard » (Finalisation de l’installation) s’affiche 
(voir Figure 2.7).

7. Cliquez sur « Finish » (Terminer). La fenêtre d’information sur ClearOne Chat (voir Figure 2.8) s’affiche.

FIGURE 2.7 Fenêtre de la finalisation de l’installation pour Chat 50

FIGURE 2.8 Fenêtre de fin d’installation de Chat 50

 



Chapitre 2 : Pour commencer     9

8. Parcourez les informations afin de vous familiariser avec les dernières informations disponibles 
sur la version dont vous disposez. Au terme de la lecture, cliquez sur « Finish » (Terminer). 
La fenêtre « Installation Complete » (Installation terminée) s’affiche (voir Figure 2.9).

9. Cliquez sur « Close » (Fermer). Vous êtes à présent prêt à configurer et tester votre Chat 50.

FIGURE 2.9 Fenêtre de fin de l’installation de Chat 50
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CONFIGURATION ET ESSAI DE VOTRE CHAT 50

1. À l’aide du câble USB 2.0 fourni, reliez Chat 50 à votre PC en suivant les indications de la Figure 2.10.

2. Le voyant est bleu, rouge et bleu à nouveau. La fenêtre « Nouveau matériel détecté » s’affiche et les
pilotes de l’appareil sont chargés. Lorsque les pilotes sont ainsi installés, cliquez sur « Finish » (Terminer).

3. Démarrez le logiciel de configuration de Chat 50 en cliquant deux fois sur l’icône Clearone Chat se
trouvant sur le Bureau (voir Figure 2.11).

4. L’écran principal de Chat 50 (voir Figure 2.12) s’affiche. Cliquez sur le bouton « Device Setup »
(Configuration de l’appareil) (voir Figure 2.13).

FIGURE 2.10 Schéma de raccordement de Chat 50 à un PC

FIGURE 2.11 Icône de Chat 50
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5. La fenêtre « Device Setup » s’affiche (voir Figure 2.14) et présente une liste des appareils disponibles
dans la colonne « Step 1: Select a device type » (Étape 1 : sélectionnez le type de l’appareil).
Sélectionnez le type d’appareil que vous souhaitez utiliser avec votre Chat 50.

FIGURE 2.12 Écran principal de Chat 50

FIGURE 2.13 Bouton « Device Setup »

FIGURE 2.14 Fenêtre « Device Setup: device type » 
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6. Sélectionnez le fabricant de l’appareil dans la liste présentée sous « Step 2: Select a manufacturer »
(Étape 2 : sélectionner le fabricant). Cliquez sur « Generic » si ce dernier ne figure pas dans la liste 
(voir Figure 2.15).

7. Sélectionnez le modèle de l’appareil dans la liste présentée sous « Step 3: Select a model » (Étape 3 :
sélectionner le modèle). Cliquez sur « Generic » si ce dernier ne figure pas dans la liste (voir Figure 2.16).

FIGURE 2.15 Fenêtre « Device Setup: device manufacturer » (Configuration : fabricant)

FIGURE 2.16 Fenêtre « Device Setup: device model » (Configuration : modèle)
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8. Cliquez sur « Step 4: Add to My Devices » (Étape 4 : ajouter à mes appareils) pour ajouter l’appareil à
la liste « My Devices » (Mes appareils). Cliquez sur le bouton « Apply to Chat » (Appliquer à Chat) pour
appliquer ces paramètres audio à votre Chat 50 (voir Figure 2.17).

9. Reliez votre Chat 50 à l’appareil que vous venez de configurer (consultez le schéma de raccordement
présenté plus bas).

> Remarque : Lorsque vous reliez le dispositif à un périphérique analogique, Chat 50 peut rester
connecté à votre PC si vous le souhaitez. Dans ce cas, vous ne devez pas débrancher le câble
d’alimentation car Chat 50 sera alimenté par le câble USB 2.0.

10. Utilisez l’appareil et notez la qualité audio supérieure du Chat 50.

11. Si vous souhaitez configurer les paramètres audio de Chat 50 pour cet appareil ou si vous souhaitez
configurer un nouvel appareil, consultez le fichier d’aide de Chat 50 (cliquez pour cela sur le bouton 
« Help » - voir Figure 2.18 - du logiciel de configuration de Chat 50) ou le Chapitre 3 : Utililisation 
du logiciel de configuration de Chat 50.

FIGURE 2.18 Bouton « Help » (Aide) de Chat 50

FIGURE 2.17 Boutons « Add to My Devices » (Ajouter à mes appareils) et « Apply to Chat » (Appliquer à Chat)



CONNEXION DE VOTRE CHAT 50

Les paragraphes suivants indiquent comment relier votre Chat 50 à d’autres périphériques.

CONNEXION DE CHAT 50 À UN TÉLÉPHONE

1. À l’aide du câble d’alimentation fourni (USB Plus uniquement), reliez Chat 50 à une prise électrique en
suivant les indications de la Figure 2.19.

2. À l’aide d’un câble téléphonique ClearOne (fourni séparément), reliez Chat 50 à la prise casque de votre
téléphone (prise 2,5 mm) selon les indications de la Figure 2.19.

NE branchez PAS le câble dans l’entrée ligne du téléphone car cela pourrait endommager le
téléphone ou le Chat 50.

14 Services techniques : 800.283.5936

FIGURE 2.19 Schéma de raccordement de Chat 50 à un téléphone
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CONNEXION DE CHAT 50 À UN TÉLÉPHONE MOBILE

1. À l’aide du câble d’alimentation fourni (USB Plus uniquement), reliez Chat 50 à une prise électrique en
suivant la Figure 2.20.

2. À l’aide du câble de 2,5-3,5 mm pour téléphone mobile, reliez Chat 50 à la prise casque de votre
téléphone mobile (ou à la prise 2,5 mm) en suivant les indications de la Figure 2.20.

FIGURE 2.20 Schéma de raccordement de Chat 50 à un téléphone mobile
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CONNEXION DE CHAT 50 À UN LECTEUR MP3

1. À l’aide du câble d’alimentation fourni (USB Plus uniquement), reliez Chat 50 à une prise électrique en
suivant les indications de la Figure 2.21.

2. À l’aide d’un câble MP3 ClearOne (fourni séparément), reliez Chat 50 à la prise casque de votre lecteur
MP3 (prise 2,5 mm) selon les indications de la Figure 2.21.

MP3

FIGURE 2.21 Connexion de chat 50 à un lecteur mp3
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CONNEXION DE CHAT 50 À UN SYSTÈME DE VISIOCONFÉRENCE

1. À l’aide du câble d’alimentation fourni (USB Plus uniquement), reliez Chat 50 à une prise électrique en
suivant la Figure 2.22.

2. À l’aide d’un câble ClearOne pour système de visioconférence (fourni séparément), reliez Chat 50 à la
prise casque de votre système de visioconférence (ou à la prise 2,5 mm) en suivant les indications de la
Figure 2.22.

FIGURE 2.22 Connexion de Chat 50 à un système de visioconférence
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DEVICE SETUP (CONFIGURATION DE L’APPAREIL)

Device Setup vous permet de configurer Chat 50 afin de l’utiliser avec l’appareil auquel il est relié pour une
totale efficacité. Configurez votre Chat 50 en suivant les étapes suivantes (consultez la Figure 3.1 pour les
étapes à suivre) :

1. Sélectionnez le type d’appareil que vous souhaitez utiliser avec votre Chat 50.

2. Sélectionnez le fabricant de l’appareil relié à votre Chat 50. Cliquez sur « Generic » si ce dernier 
ne figure pas dans la liste.

3. Sélectionnez le fabricant de l’appareil relié à votre Chat 50. Cliquez sur « Generic » si ce dernier 
ne figure pas dans la liste.

4. Cliquez sur « Add to My Devices » (Ajouter à mes appareils) pour ajouter l’appareil à la liste 
« My Devices » (Mes appareils).

5. Un message s’affiche et vous indique que l’appareil a été ajouté à votre liste. Cliquez sur le bouton 
« Apply to Chat » (Appliquer à Chat) pour appliquer ces paramètres audio à votre Chat 50.

6. Un message s’affiche et vous indique que les paramètres ont été appliqués à Chat 50.

CHAPITRE 3 : UTILISATION DU LOGICIEL 
DE CONFIGURATION CHAT 50

FIGURE 3.1 Fenêtre « Device Setup  »
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MY DEVICES (MES APPAREILS)

La fenêtre « My Devices » (Mes appareils) (voir Figure 3.2) présente tous les appareils que vous avez
configurés pour une utilisation avec Chat 50.

Sélectionnez simplement l’appareil que vous souhaitez utiliser avec votre Chat et cliquez ensuite sur le bouton 
« Apply to Chat » (Appliquer à Chat) pour appliquer ces paramètres audio à votre Chat 50.

Si par la suite vous voulez supprimer un appareil de votre liste « My Devices », sélectionnez l’appareil et
cliquez ensuite sur le bouton « Remove from My Devices » (Supprimer de mes appareils). (Cette opération
supprime l’appareil de la liste sans pour autant le supprimer de la base de données - Voir Paramètres avancés :
Base de données à la page 26 pour des informations complémentaires).

FIGURE 3.2 Fenêtre « My Devices »
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UPDATE FIRMWARE (MISE À JOUR DU MICROPROGRAMME)

Cliquez sur le bouton « Update Firmware » (Mise à jour du microprogramme) pour afficher la fenêtre de mise
à jour du microprogramme (voir Figure 3.5).

La version actuelle du microprogramme et le nom de l’unité s’affichent. Suivez les étapes suivantes pour
mettre le microprogramme à jour :

1. Cliquez sur le bouton « Check for updates » (Vérifier les mises à jour) afin de vérifier si des mises à jour
sont disponibles. Vous pouvez aussi cliquer sur « Select File » (Sélectionner fichier) pour sélectionner le
fichier de microprogramme dans le répertoire Firmware de Chat 50 sur votre PC.

> Remarque : Le PC auquel Chat 50 est relié doit être connecté à l’Internet afin de pouvoir utiliser la
fonction de vérification des mises à jour.

2. Si vous avez cliqué sur le bouton « Check for updates » (Vérification des mises à jour), passez à 
l’étape 3. Si vous avez cliqué sur « Select File » (Sélectionner un fichier), passez à l’étape 4.

3. Les messages suivants s’affichent au-dessus de la barre de progression :

• Locating website... (Recherche du site)

• Website found. (Site trouvé.)

• New firmware found. (Nouveau microprogramme disponible) 
(Uniquement si un nouveau fichier est disponible)

• Check for updates finished. (Vérification des mises à jour terminée).

Si aucune mise à jour n’est disponible, le message suivant s’affiche sous la barre de progression 
« Your device contains the most recent firmware » (Votre appareil dispose du microprogramme le plus
récent). La mise à jour n’est donc pas nécessaire.

FIGURE 3.5 Fenêtre de mise à jour
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Si une mise à jour est disponible, le message suivant s’affiche sous la barre de progression « Click
Update to load new firmware in device » (Cliquez sur Update pour charger le nouveau microprogramme)
(voir Figure 3.6). Passez à l’étape 5.

4. Sélectionnez le fichier parmi les mises à jour disponibles pour Chat 50 (voir Figure 3.7) et cliquez sur OK.

5. Cliquez sur le bouton « Update » pour mettre à jour le microprogramme de Chat 50.

FIGURE 3.6 Fenêtre de mise à jour : prêt pour la mise à jour

FIGURE 3.7 Sélection du fichier
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6. Une série de messages (« Setting programming mode » - Configuration du mode de programmation - 
« Resetting device » - Réinitialisation de l’appareil - « Programming » - Programmation - « Firmware upgrade
succeeded » - Mise à jour du microprogramme effectuée) s’affichent au-dessus de la barre de progression
et vous donnent des indications sur l’avancement de la manœuvre. Au terme de la mise à jour, le message
suivant s’affiche : « Update Successful! The firmware for device Chat 50 has been changed to <nouvelle
version> » (Mise à jour effectuée ! Le microprogramme pour Chat 50 est passé à la version <nouvelle
version>) où <nouvelle version> fait référence à la version du microprogramme (voir Figure 3.8).

7. La nouvelle version du microprogramme et le nom de l’unité s’affichent.

FIGURE 3.8 Fenêtre de mise à jour : mise à jour effectuée
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HELP (AIDE)

Le bouton « Help » (voir Figure 3.9) fournit les informations suivantes :

• Cliquez sur « Help » pour accéder au fichier d’aide en ligne.

• Cliquez sur « About » (À propos de) pour obtenir des informations sur votre Chat 50.

• Cliquez sur « ClearOne Homepage » pour accéder au site Internet de ClearOne à l’aide de votre
navigateur par défaut.

• Cliquez sur « Registration » (Enregistrement) pour enregistrer votre Chat 50 à l’aide de votre navigateur
par défaut.

ADVANCED (AVANCÉ)

Cliquez sur le bouton « Advanced » (Avancé) pour afficher la fenêtre « Advanced Settings » (Paramètres
avancés) (voir Figure 3.10).

La fenêtre « Advanced Settings » présente les paramètres audio pour votre Chat 50. À partir de cette
fenêtre, vous pouvez ajuster les paramètres audio pour votre Chat 50, visualiser et modifier la base de
données de Chat 50 et afficher le fichier journal de Chat 50. Les paragraphes ci-dessous présentent 
chaque paramètre.

FIGURE 3.9 Bouton « Help »

FIGURE 3.10 Fenêtre « Advanced Settings » 
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ADVANCED SETTINGS : AUDIO SETTINGS (PARAMÈTRES AVANCÉS : PARAMÈTRES AUDIO)

Utilisez la fenêtre « Audio Settings » (voir Figure 3.11) pour passer en revue les paramètres audio pour le 
Chat 50 actuellement relié au PC. Vous pouvez aussi créer des paramètres audio personnalisés pour un
appareil (voir Advanced Settings : Database à la page 26). Les paramètres audio disponibles sont les suivants :

• Input Audio Level (Niveau d’entrée) : utilisez le curseur pour ajuster le volume sonore transféré au 
Chat 50 par le périphérique auquel il est relié. (uniquement en présence d’appareils reliés à l’aide du
câble de 3,5 mm).

• Output Audio Level (Niveau de sortie) : utilisez le curseur pour ajuster le volume sonore transféré du
Chat 50 au périphérique auquel il est relié. (uniquement en présence d’appareils reliés à l’aide du câble 
de 3,5 mm).

• Disable Speaker (Désactiver le haut-parleur) : cochez cette case pour désactiver le haut-parleur du 
Chat 50. Utilisez cette fonction lorsque vous souhaitez utiliser des haut-parleurs externes d’un système 
de visioconférence relié au Chat 50 à l’aide d’un câble de 3,5 mm.

> Remarque  : si le haut-parleur a été désactivé de la sorte, la fonction anti-écho sera inactive à moins
que le système de visioconférence connecté au Chat 50 par le câble de 3,5 mm permette
l’annulation de l’écho. Contactez l’Assistance technique pour de plus amples informations.

• Line Echo Cancellation (anti-écho) : cochez cette case pour annuler l’écho. Cette fonction permet
d’annuler l’écho généré lorsque le Chat 50 est relié à un téléphone ou à un téléphone mobile. Il s’agit de
l’écho de votre voix. Si celui-ci n’est pas annulé, il provoque un retour sur le haut-parleur.

• Enable USB/Analog Mix (Activer le mixage USB/analogique) : cochez cette case pour permettre à la
personne reliée au Chat 50 par un câble de 3,5 mm d’entendre le son passant sur l’appareil. Par exemple,
si cette case est cochée et que vous écoutez un CD sur votre Chat 50, la personne avec laquelle vous
êtes en communication sur votre téléphone mobile peut l’entendre si votre téléphone est relié au Chat 50
par un câble de 3,5 mm. (uniquement en présence d’appareils reliés à l’aide du câble de 3,5 mm).

Les modifications apportées dans cette fenêtre entrent immédiatement en vigueur si le Chat 50 est relié à
votre PC.

FIGURE 3.11 Fenêtre « Advanced Settings : Audio settings »
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ADVANCED SETTINGS : DATABASE (PARAMÈTRES AVANCÉS : BASE DE DONNÉES)

Utilisez la fenêtre « Database » (voir Figure 3.12) pour passer en revue et modifier la base de données de
Chat 50. La base de données de Chat 50 comprend tous les paramètres audio préenregistrés par ClearOne
(et marqués par      dans la liste) ainsi que vos paramètres personnels. Le signe      indique que l’appareil
figure dans votre liste « My Devices » (Mes appareils).

Pour afficher les paramètres relatifs à un appareil donné, sélectionnez l’appareil et cliquez sur le bouton 
« View » (Afficher). Vous pouvez aussi cliquer deux fois sur le nom de l’appareil. La boîte de dialogue 
« View Database Record » (Afficher l’entrée de la base de données) (Voir Figure 3.13) s’affiche. Cliquez sur
OK pour fermer la boîte de dialogue.

FIGURE 3.12 Fenêtre « Advanced Settings: Database » 

FIGURE 3.13 Fenêtre « View Database Record » 
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Pour sauvegarder des paramètres personnalisés pour un appareil, procédez comme suit :

1. Cliquez sur le bouton « New » (Nouveau). La fenêtre « Add Settings to Database » (Ajouter les
paramètres à la base de données) s’affiche (voir Figure 3.14).

2. Ajustez les paramètres audio ou cliquez sur le bouton « Upload from Chat » (Charger à partir de Chat)
pour charger et afficher les paramètres audio en cours.

3. Cliquez sur les flèches et sélectionnez le type d’appareil, le fabricant et le modèle de votre appareil.
Vous pouvez aussi entrer un nom si vous préférez.

4. Décochez la case « Include in My Devices » (Inclure dans Mes appareils) si vous ne souhaitez pas
ajouter l’appareil à la liste « My Devices » (Mes appareils). (Par défaut, le nouvel appareil sera ajouté à la
liste My Devices). Au terme de l’opération, cliquez sur OK. (Si vous avez commis une erreur, vous pouvez
annuler toutes les modifications en cliquant sur le bouton Cancel).

5. L’appareil personnalisé est ajouté à la base de données de Chat 50 et vous pouvez à présent y accéder 
à l’aide de la fenêtre « Device Setup » (Configuration de l’appareil). (L’icône ClearOne ne s’affiche pas à
proximité de votre appareil dans la base de données afin de le distinguer des appareils préprogrammés).

Pour modifier les appareils personnalisés, cliquez simplement sur le bouton « Édit » (remplace le bouton 
« View » pour les périphériques personnalisés) après avoir sélectionné l’appareil que vous souhaitez modifier.
La fenêtre « Edit Database Record » (Modifier une entrée de la base de données) s’affiche (voir Figure 3.15).

FIGURE 3.14 Fenêtre « Add Settings to Database » 

FIGURE 3.15 Fenêtre « Edit Database Record »
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Ajustez les paramètres audio ou cliquez sur le bouton « Upload from Chat » (Charger à partir de Chat 50)
pour charger les paramètres audio en cours. Au terme de la modification de l’entrée, cliquez sur OK. Si vous
souhaitez annuler vos modifications, cliquez sur « Cancel » (Annuler).

Pour supprimer les périphériques personnalisés de la base de données, cliquez sur le bouton « Delete »
(Supprimer) après avoir sélectionné l’appareil que vous souhaitez supprimer. Vous ne pouvez supprimer 
que les appareils personnalisés. Vous ne pouvez pas supprimer les appareils préprogrammés (appareils
présentant l’icône ClearOne).

ADVANCED SETTINGS : LOG (PARAMÈTRES AVANCÉS : JOURNAL)

Le journal de Chat 50 (voir Figure 3.16) affiche la liste des opérations effectuées par Chat 50 avec la date,
l’heure et une description de l’opération ou de l’événement.

Si vous souhaitez sauvegarder le journal vers un fichier texte, cliquez simplement sur le bouton « Save »
(Sauvegarder). Une fenêtre standard s’affiche et vous demande d’entrer un nom pour le fichier et de
sélectionner le répertoire de destination. Le répertoire par défaut est le répertoire Log de Chat 50.

Cliquez sur « Clear » (Réinitialiser) pour vider la fenêtre.

FIGURE 3.16 Fenêtre « Advanced Settings: Log » 
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VOYANT D’ALIMENTATION

Le voyant d’alimentation est bleu lorsque Chat 50 est relié au PC par un câble USB 2.0 ou lorsque le cordon
d’alimentation est branché. Le voyant clignote en rouge lorsque Chat 50 est en mode Sourdine (mute).

BOUTONS DE CONTRÔLE DU VOLUME ET BOUTON MUTE

Vous pouvez utiliser les boutons Haut et Bas pour ajuster le volume de Chat 50. Utilisez le bouton Mute pour
couper le microphone de Chat 50 jusqu’à ce que vous appuyiez à nouveau sur le bouton Mute. Si vous
utilisez Chat 50 avec un PC, vous pouvez aussi utiliser le Contrôle du volume de Windows.

> Remarque : Si votre Chat 50 est relié à un PC, toute modification apportée au volume et la mise en
sourdine de l’appareil à l’aide des boutons de Chat 50 sont transférées vers la fenêtre Contrôle du
volume de Windows.

CHAPITRE 4 : UTILISATION DE CHAT 50
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ENTRETIEN DE VOTRE CHAT 50

•  Respectez toutes les consignes et les instructions figurant sur votre Chat 50.

• Débranchez le câble USB du Chat 50 avant de le nettoyer.

• Débranchez l’alimentation de la prise murale (USB Plus) avant de le nettoyer.

• N’utilisez ni liquide ni aérosol. Utilisez un chiffon humide pour nettoyer la coque externe de votre Chat 50
et le câble d’alimentation.

DÉPANNAGE

Si vous rencontrez des problèmes lors de l’utilisation du Chat 50, il est possible que le périphérique utilisé ne
soit pas adapté ou qu’il y ait un problème matériel.  

• Activez le logiciel de configuration de Chat 50 et vérifiez les paramètres audio pour le périphérique relié au
Chat 50. Si cela ne résout pas le problème, examinez plus en détail l’appareil afin de vérifier l’origine du
problème (consultez le manuel de votre appareil ou contactez l’assistance technique).

• Veillez à ce que tous les câbles soient correctement connectés. Vérifiez les branchements sur la base des
schémas fournis (voir Chapitre 2 : Connexion de votre Chat 50).

• Si vous connectez votre Chat 50 à un concentrateur USB, veillez à ce que le concentrateur USB soit relié à
une source d'alimentation externe.

CHAPITRE 5 : ENTRETIEN
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RÉCUPÉRATION SUITE À L’INTERRUPTION DE LA MISE À JOUR DU MICROPROGRAMME

Si la programmation du microprogramme est interrompue (en cas de panne de courant ou si le câble est
débranché), le Chat 50 peut devenir instable.

• Pour récupérer une erreur de programmation si le Chat 50 n’est plus reconnu par le système
d’exploitation, débranchez le câble USB du Chat 50, maintenez le bouton MUTE enfoncé alors que vous
reconnectez le Chat 50 et répétez la mise à jour.

L’écran de récupération « Update Firmare » (Mise à jour du microprogramme (voir Figure 5.1) s’affiche.
Procédez à la mise à jour du microprogramme en suivant les instructions de la page 21. Les messages 
« Initialiazing » (Initialisation) et « Recovering » (Récupération) s’affichent au-dessus de la barre de
progression. Les messages de mise à jour s’affichent ensuite (voir étape 6 de la procédure de mise 
à jour du microprogramme à la page 23). La mise à jour s’achève ensuite.

• Le Chat 50 peut également tenter une récupération suite à un problème de programmation en
redémarrant et en procédant à la mise à jour (mode DFU). Dans ce cas, procédez à la mise à jour 
du microprogramme.

FIGURE 5.1 Écran de récupération de la mise à jour du microprogramme
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CARACTÉRISTIQUES TECHNIQUES

Connections
Prise USB 
Compatible version 2.0
Type : Mini B

Sortie audio
Type : Mini-prise 3,5mm (1/8”)
Embout : Sortie ligne (transmission)
Sonnerie : Entrée ligne (réception)
Manchon : terre 

Courant en continu 

Commandes
Augmentation du volume
Diminution du volume
Mise en sourdine du micro

Audio
Haut-parleur
Bande passante : 150 Hz-15 kHz
Niveau de sortie max : 80dBSPL à 30 cm 

Microphone 
Bande passante : 50 Hz-8 kHz 

Entrée ligne 
Réponse en fréquence : 20 Hz-20 kHz +/- 1 dB
Niveau d’entrée maximal : 0 dBu
Impédance d’entrée : 10K Ohms 

Sortie ligne 
Réponse en fréquence : 20 Hz-20 kHz +/- 1 dB
Niveau de sortie maximal : 0 dBu
Impédance de sortie : 50 Ohms

Traitement du signal
Système anti-écho
Système anti-bruit
Système anti-écho sur la ligne (sélection)

Alimentation
Alimentation par USB
5 VDC à 500 mA maximum

Alimentation externe 
Entrée 120-140 VCA
Sortie 7 VCC à 500 mA

Environnement
Température de fonctionnement : 0-50 °C

Mécaniques
Dimensions (l x L x H) : 9,7 cm x 10,4 cm x 4,8 cm (3.8” x 4.1” x 1.8”)
Poids : 0,25 kg (0,55 lbs.)

Logiciel
Windows XP

CHAPITRE 6 : ANNEXE
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CONFORMITÉ

FCC PART 15/ICES-003

Ce matériel a été testé et déclaré conforme aux normes dans les limites du matériel électronique de catégorie B
conformément à la section 15 des réglementations FCC. Ces limites sont conçues pour fournir une protection
raisonnable contre les interférences nuisibles lors d’une installation résidentielle. Ce matériel génère, utilise et peut
émettre une fréquence radio. En cas d’installation et d’utilisation inadéquates, il peut gêner les communications
radio. Le présent document ne garantit nullement que les interférences ne se présentent pas lors d’une installation
donnée. Si le matériel gêne la réception radio ou TV mise en évidence par une mise sous tension et hors tension
de l’appareil, l’utilisateur est encouragé à tenter de résoudre le problème en procédant comme suit :

• En réorientant ou en déplaçant l’antenne.

• En mettant une distance plus importante entre le matériel et le récepteur.

• En reliant l’appareil à une prise se trouvant sur un circuit autre que celui auquel le récepteur est connecté.

• Contactez votre revendeur ou un technicien Radio/TV spécialisé pour obtenir de l’aide.

RESPECTE LES NORMES FCC PART 15.19(A) (3) 

Cet appareil respecte la section 15 de la réglementation FCC. Son utilisation est soumise aux deux conditions
suivantes : 1) cet appareil ne doit pas provoquer d’interférences nuisibles ; 2) cet appareil doit tolérer toutes
les interférences, y compris celles qui sont susceptibles de provoquer un fonctionnement non désiré de
l’appareil.

CONFORMITÉ AUX RÈGLES EUROPÉENNES

Voir la Déclaration de conformité incluse dans l’équipement pour plus de détails. La conformité de cet
équipement avec la directive est attestée par l’application de la marque CE sur l’équipement.

GARANTIE

ClearOne Communications, Inc. (Fabricant) garantit ce produit contre toute défectuosité qu’il s’agisse du
matériel ou de l’assemblage. Pour des renseignements sur la garantie et sa couverture, veuillez vous reporter
au site internet de ClearOne à l’adresse suivante : www.clearone.com.

ClearOne Communications Inc.
1825 Research Way
Salt Lake City, Utah 84119


